
PageSender: fax software that really works for Mac OS X

Fax using your Apple Internal Modem, external modem, fax-equipped mobile phone, or fax-

via-email service. Fax or email (PDF) anything you can print under Mac OS X. PageSender 

presents a fully-functional fax or email envelope when you print - just fill in the envelope, 

click "Print", and your document is on its way. PageSender emails printouts as Portable 

Document Files (PDF), viewable with Adobe Acrobat Reader on Windows, Mac OS, and 

Linux.
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Welcome to PageSender

PageSender is full-featured fax software for Mac OS X. PageSender enables you to 

Fax or Email anything you can print, directly from the print dialog. PageSender 

can also receive faxes using your fax modem and automate sending & receiving 

faxes! Fax using your Apple Internal Modem, external modem, fax-equipped 

mobile phone, or fax-via-Email service.

Read what's new in this version of PageSender.

Features:

�●     Send faxes and (PDF) emails directly from the print dialog 

�●     Receive faxes using your fax modem 

�●     Print, Email, and even AppleScript received faxes 

�●     Use with any popular address book or Email client 

�●     Live addressing with Address Book, Entourage, Now Contact (4.2.5 and later), 

Outlook Express, and Palm Desktop (4.1 and later) 

�●     Attach additional PDF documents when faxing 

�●     Use any font on your system (including Chinese, Japanese, Korean) 

�●     Send faxes easily via eFax, jConnect, EasyLink, or MaxEmail services 

�●     Automate sending of faxes and (PDF) Emails via AppleScript 

�●     Available in English, Japanese, German, Italian, and French 

System Requirements 

Updates & Purchasing 

Installing 

Help 

Uninstall 

Disclaimer

System Requirements

Mac OS X 10.4 or above.

Send via these Email applications:

Eudora, Mail, Mailsmith, Microsoft Entourage, PowerMail

Drag & drop support for these address books:

Address Book, Eudora, Mailsmith, Microsoft Entourage, Now Contact, 

Palm Desktop, PowerMail (and vCard files)
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Fax support for these services:

Fax modem, eFax.com, jConnect (j2.com), EasyLink, EasyLink UK, 

MaxEmail, Send2Fax

Updates & Purchasing

You can find the latest version of PageSender and technical support at:

http://www.pagesender.com

PageSender costs US $39.95 and may be purchased from the demo or from:

the SmileOnMyMac web store

Users of PageSender 1.X, 2.X, and 3.X upgrade to PageSender 4.X for $20, or free if 

PageSender was purchased or upgraded on or after January 1 2007.

How do I Install PageSender?

Drag PageSender Fax Center from its disk image to your Applications folder, or wherever 

you prefer to put your applications. Launch PageSender Fax Center, and you'll be asked if 

you'd like to install the PageSender printer driver software. You'll need to install the 

PageSender printer driver software before you can use PageSender.

Once installed, you may wish to customize your setup.

Where can I get help with PageSender?

PageSender ships with extensive online help. Select PageSender Help (Help Viewer) from 

the Help menu of PageSender Fax Center to view the help with Apple's Help Viewer 

application, or select PageSender Help (Web Browser) to view the PageSender Help in 

your default web browser. Browser help is also available.

How do I Uninstall PageSender?

Launch the PageSender Fax Center application and select Uninstall PageSender… from 

the PageSender Fax Center menu.

Launch Printer Setup Utility and remove the Page Sender printer.

Drag the PageSender Fax Center application icon from your Applications folder to the Trash.

Restart your computer.

How do I remove my faxes and preferences?

Launch Terminal (in Utilities folder of Applications) 

Run the following commands (which won't require your admin password):

defaults delete com.smilesoftware.print.pagesender 

defaults delete com.smilesoftware.print.pagesenderfaxcenter
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Locate the [HOME] Library/Page Sender folder, and drag it to the Trash.

Disclaimer

This software is provided "as is" and any express or implied warranties, including, but not 

limited to, the implied warranties of merchantibility and fitness for a particular purpose are 

disclaimed. In no event shall the copyright owner or contributors be liable for any direct, 

indirect, incidental, special, exemplary, or consequential damages (including, but not 

limited to, procurement of substitute goods or services; loss of use, data, or profits; or 

business interruption) however caused and on any theory of liability, whether in contract, 

strict liability, or tort (including negligence or otherwise) arising in any way out of the use 

of this software, even if advised of the possibility of such damage.

PageSender is produced by:

SmileOnMyMac, LLC 

PMB 278 

350 Bay Street, Suite 100, 

San Francisco, CA 94133

We welcome your inquiries and feedback at: support@pagesender.com
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help: setup

PageSender includes two printer drivers, that are added automatically to Printer Setup 

Utility on your computer when you first launch the PageSender Fax Center application after 

installation. To open PageSender Fax Center, double-click its icon in your Applications 

folder. If the drivers are not added automatically, or if you remove them, you will need to 

re-add PageSender to Printer Setup Utility. PageSender's two drivers are PageSender-Fax, 

for faxing, and PageSender-Email, for emailing as a PDF.

Adding PageSender to Printer Setup Utility

1.  Open Printer Setup Utility (which is found in the Utilities folder inside the 

Applications folder. 

2.  Click the Add button in the Printer List window toolbar. 

3.  Select PageSender-Fax in the Printer Browser 

4.  Press the Add button 

5.  Repeat above with PageSender-Email at step 3. 

PageSender-Fax and PageSender-Email will be added to your Printer List and the first set 

to the default printer.

If you do not wish PageSender to be your default printer, choose a different printer from 

the list and press the Make Default button in the toolbar.

PageSender supports a wide variety of Email applications, address books, and fax services, 

as well as your fax modem. See here for details.

If your Email client, address book application, or fax service is not supported by 

PageSender please submit a feature request and we'll see what we can do.

Why Does Installing PageSender Require Admin Access?

Printer drivers consist of files which must be stored in protected areas of the system, and 

access to those folders requires admin privileges.

Login and Sleep

PageSender can only receive faxes when logged in to a user account. PageSender can 

receive faxes when your computer is asleep, provided your computer supports the Wake 

when the modem detects a ring option found in System Preferences � Energy Saver � 

Options. If that option is checked, your computer will wake when the phone rings then 

PageSender will answer after its set number of rings.

Using PageSender with a Cable / DSL Internet Connection

Faxing is a phone technology and ultimately requires a voice phone line. Since faxing 

occurs over a voice phone line, it has nothing to do with DSL or cable modems. 5
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PageSender can use your Apple Internal Modem (or an external fax modem) to connect to 

a voice phone line directly. PageSender can also serve as a client for several fax-via-Email 

services (efax.com, jConnect, MaxEmail, EasyLink) which maintain the phone line and 

modem for you (and charge you a fee for that service). You can fax using a voice line 

which is also running DSL, just as you can make voice phone calls with the same line (be 

sure to install your DSL filters). One advantage to the fax-via-Email services is that you 

can avoid tying up your voice line if you have a DSL or Cable modem as your Internet 

connection because your Email will be sent via your DSL or Cable modem, but again you 

pay for the privilege.

Using PageSender with Internet Fax Services

If you wish to use PageSender to send faxes with eFax.com, jConnect, or EasyLink, you 

must already be a paid subscriber of the service you wish to use. For more information 

about these services, please visit their respective websites:

eFax.com

jConnect (formerly, jFax)

EasyLink (formerly, faxSav)

Sharing a Fax Line with a Telephone or Answering Machine

To share a line well, it is necessary to differentiate incoming calls. Differentiating calls is a 

hardware function. Some fax machines can differentiate voice and fax calls. They do this 

by answering all calls immediately. They then provide their own electronic ring sound (and 

continue to ring the attached telephone) to reassure voice callers while "listening" for fax 

calling tones. If they detect a fax calling tone, they answer. Otherwise they continues to 

ring. For good measure, they pick up with a fax answer tone after many rings in case the 

incoming fax machine isn't sending calling tones.

Boxes which provide just the fax detection function then "ring through" to either the fax 

machine or phone depending on the type of call are available. Customers report using the 

Emerson Switchboard and the ComSwitch. Combine this hardware solution with your 

computer (running PageSender) hooked up to the "fax" output of the box and your 

answering machine hooked up to the "voice" output of the box.

You might also consider splitting your fax line and using a USB-based answering device 

such as the Ovolab Phlink or the Parliant PhoneValet. Both of these devices can be set to 

detect incoming faxes and hand them off to PageSender. Note that you must uncheck 

Receive faxes after X rings in the Receive preferences of PageSender Fax Center when 

using such devices to answer fax calls. Attach one end of your split fax line to the USB-

based device and the other to your fax modem.

Printer Sharing: Using PageSender with Multiple Computers

PageSender supports Printer Sharing, which means that you can have a setup where only 

one computer is connected to a phone line and modem, and does all the fax sending and 

receipt. Other machines can send through PageSender on that computer, shared as a 

shared printer.

There are some limitations to using PageSender in this way:
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�●     Status information will be displayed in PageSender Fax Center only on the 

computer running Printer Sharing. 

As of PageSender 4, cover pages are sent along with the print job and so there's no need 

to change anything on the machine running Printer Sharing.

 
© 2007 SmileOnMyMac, LLC. All rights reserved. 

PageSender is a trademark of SmileOnMyMac, LLC.

7



help: sending a fax

1. In any Mac OS X application, select Print from the File menu.

2. Select PageSender-Fax as your Printer.

3. Select PageSender Fax from the Copies & Pages popup menu if it's not already selected 

for you.

PageSender presents an envelope which lets you fax anything you can 

print:

4. Click the Open Address Book button.

5. Drag an address into the white area above the Open Address Book button.

6. Specify any additional options you want:

�●     Click the Cover Page tab if you want to include a cover page with your fax. 

See the Custom Cover Pages help section for more information. 

�●     Click the Attachments tab if you wish to attach additional PDF or image documents 

to your fax. 

�●     Click the Options tab if you wish to schedule when your fax is sent, 

or select a specific originating email address other than the default if you are 

using a fax by email service. 

7. Press the Print button.8
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If you are using a fax modem, PageSender Fax Center will launch in the background and 

begin dialing.

If you are using eFax.com, jConnect, or EasyLink, your Email application will open in the 

background and your fax will be sent via Email. The sent message will be placed in your 

Email application's sent messages folder.

 
Note: PageSender supports sending via fax modem, and the following services: eFax.com, 

jConnect, EasyLink, or MaxEmail. You must be a subscriber to send via those services.

 
Legal Note: eFax and jConnect services are provided by J2 Communications. EasyLink 

services are provided by EasyLink. MaxEmail services are provided by IGC. SmileOnMyMac 

makes no warranty regarding these services. Using PageSender with these services is 

intended as a convenience and could cease to function in the future.
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help: sending a fax � attachments, scheduling, & addressing

Attachments

PageSender supports faxing additional documents along with the one you are printing. To 

add additional documents to your fax, press the Attachments button in the PageSender Fax 

portion of the Print dialog.

Drag PDF files from the Finder to the attachments list. Re-arrange the order of documents 

in the fax by dragging attachments around within the list.

Scheduling Faxing

To access scheduling options, press the Options button in the PageSender Fax portion of 

the Print dialog.

You may schedule your fax for sending Now, At: a specific time and date, or choose Hold to 

defer the sending of your fax. A fax kept on hold will remain in the Out folder of 

PageSender Fax Center. To send a fax on hold you will need to go to PageSender Fax 

Center's Out folder, select the fax there and press the Resend button.

Faxing by Email Options

You may select the Email address used for fax-to-Email services such as eFax.com, 

jConnect, EasyLink, and MaxEmail in the options pane.

Add Addresses from Text Files 

PageSender supports adding addresses from a text file. Drag & drop your text file into the 

address list in the Print dialog, and your addresses will be added. Each line should be either 

3 or 4 columns and each entry on the line should be separated by commas or spaces. The 

columns are: name, company, number, and optionally country code. Styles can be mixed 

within a single file. Here are examples of valid lines:

Greg Scown,Smile Software,+1-408-884-2320
Philip Goward,SmileOnMyMac,408-884-2320,1
Greg Scown      Smile Software  +1-408-884-2320
Philip Goward   SmileOnMyMac    408-884-2320    1

Live Addressing 

PageSender includes support for live address look up and completion. The following 

address book applications support live addressing:

�●     Address Book (Mac OS X) 

�●     Microsoft Entourage 

�●     Now Contact (v4.2.5 and later) 

�●     Outlook Express (Classic) 
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To use live addressing, you must use a supported address book (see above) and the Use 

live addressing (when supported) checkbox must be checked in your Email and/or Fax 

preferences in PageSender Fax Center.

Click Add to add a new recipent, then type a partial name (first or last - e.g. “Greg”) in the 

Name column of the Email or Fax envelope and PageSender will present you with a list of 

possibilities. Double-click your choice and it will be placed in the recipient list. Continue 

typing to narrow your selection and pause when you'd like a new list of possibilities.

How Live Addressing Works

PageSender reads addresses from the Address Book application automatically.

For other applications, PageSender uses AppleScript to query your address book. In order 

to do this, your address book must be running. Therefore, if you have live addressing 

enabled, your address book application will be launched when you bring up PageSender in 

the Print dialog. Using AppleScript allows us to offer live addressing for several different 

address book applications and enables addition of other address book applications in the 

future.

Disabling Live Addressing

If you would rather not use live addressing or would prefer that PageSender not launch 

your address book:

1.  Launch PageSender Fax Center from your Applications folder 

2.  Select Preferences in the PageSender Fax Center menu 

3.  Press the Email and/or Fax button in the Preferences toolbar 

4.  Uncheck the Use live addressing (when supported) checkbox 
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help: PageSender Fax Center

PageSender Fax Center allows you to monitor faxes you've sent via fax modem and to set 

PageSender preferences.

Fax Center Window

The Fax Center window presents a list of faxes and their status. If there is a number next to the 

status field, it indicates the attempt number in progress. For example, "Sending (2)" indicates 

that the second attempt to send that fax is in progress.

These are the operations you can do with a selected fax:

Remove Press Delete in the toolbar.

Abort Sending For a fax in progress: press Delete in the toolbar.

Resend Press Resend in the toolbar.

View Press View in the toolbar to view the fax with the default viewer application for 

its file type.

Get Info Press Get Info in the toolbar to see information about the fax. Get Info for 

outgoing faxes may be used to:

�●     Set the number of tries and interval between tries for a specific 

outgoing fax 

�●     Set the time after which the fax is scheduled to be sent 

�●     Edit mistakes in outgoing fax numbers (then use the Resend button) 

�●     See the Dial String exactly as it will be sent to your modem 

Mark as Read Select fax(es) then choose Mark as Read from the Fax menu to mark faxes 

as read. Unread faxes appear with a blue dot.
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Mark as Spam Select fax(es) then choose Mark as Spam from the Fax menu to mark faxes 

as spam, add the station name of the received fax to the Spam Station Names 

list in the Spam preferences, and move the fax to the Spam folder.

Drag and drop a fax to make a copy of that fax in the drag destination, or drag to an application 

(in the Dock) to open the fax with that specific application.

Manual Answer

If you receive a phone call on a line shared with your computer and determine 

that call is an incoming fax, press the Manual Answer button to begin 

receiving the incoming fax immediately. Hang up the phone when you see 

Answering call in the status bar. (Note: Manual Answer is not available when 

Receive faxes after X rings is checked in the Receive preferences.)

Manual Send

If you would like to dial the phone yourself and then initiate the fax, press the 

Manual Send button. You will be presented with a sheet which asks you to dial 

the number then press Send Now when you hear the fax tone. The sheet will 

disappear when it's okay for you to hang up.

Log

The Log window (Window–Log) shows detailed feedback from efax, the Unix 

utility used to send faxes. If your fax is not being sent, you should take a look 

to see if there are any error messages in the log.

History

The History window shows historical information on fax activity. You may limit 

the history by date, and you may print the history for your records. Because 

the history is intended for record-keeping purposes, it may not be edited.

Preferences

Page

The Fax Number and Station Name appear at the top of any faxes you send. 

Generally, the fax number is of the format: +1 408 884 2320 where 1 is the country 

code and 408 is the area/city code. Generally the station name is all caps; for 

example: SMILE SOFTWARE.

Modem

Select the Modem Type you are using and specify your preferred Speaker Behavior 

and Speaker Volume.

Expert users may wish to set the Initialization String being careful to precede 

separate entries with "-i". If your modem is made by one of the manufacturers in the 

list, you may get better performance by choosing it from the Flow Control popup.

Dialing

Click here for more information on how to set the dialing preferences.

Receive

Click here for more information on how to set the receive preferences.
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Send

You can choose to print a confirmation sheet on sending, along with a copy of sent 

faxes, and a record of failed sends.

When a fax is sent you can also select to send email notification, or even run an 

AppleScript to completely customize send notification.

The Send preferences also allow you to select the application used to view sent faxes.

Fax

Select your Fax service and Fax address book of choice.

Email

Select your Email client and Address book of choice.

If you wish to be carbon copied (CC) on outgoing PageSender emails, check Copy me 

on PageSender Emails. Note that outgoing PageSender emails are always saved in 

your email client's Sent Mail folder.

Spam

Incoming faxes can be filtered and treated as spam. Filtering can be turned on or off, 

and is achieved by comparing the station name of the fax being received with a list 

that you provide. You can also choose to hang up immediately once a spam fax is 

detected, as well as where to file spam faxes.
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help: Custom Cover Pages

Click the Cover Page tab of the PageSender Fax envelope in the Print dialog to select, 

create and add your own custom cover pages.

Select a Cover Page

Choose No Cover Page to send your fax without a cover page. Choose Default Cover Page 

to send your fax with PageSender's default cover page. Or, choose any of your custom 

cover pages which appear in the menu to use those. For example, you might choose My 

Custom Cover to use that as your cover page.

Create a Custom Cover Page

To create your own custom cover page, choose New RTFD Cover Page or New PDF Cover 

Page from the cover page pop-up menu. Name your new cover page and specify where it 

will be stored. Your new copy of the default cover page will open in TextEdit if you chose 

RTFD, or PDFpen if you chose PDF. Edit your new cover page to suit your tastes. You can 

use PDFpen to edit cover pages even if you did not purchase a copy of PDFpen. Download 

a copy of PDFpen here. PageSender will automatically suppress watermarks in cover pages 

created from an unregistered copy of PDFpen. The PDF format will give more flexibility in 

laying out your cover page to get precisely the look you want.

If any of these tags appear in your cover page, they will be replaced as follows:

<PAGESENDER-SENDER> Will be replaced by your long user name. 

(The Name field as it appears in the 

Users panel of the System Preferences.)

<PAGESENDER-RECIPIENT> Current recipient of the form First Last 

(Company) or First Last if no company is 

specified.
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<PAGESENDER-RECIPIENTS> List of all recipients of the form: First 

Name (Company), Second Name 

(Company). Note: Pay careful attention 

to how you indent this field. We 

recommend you turn on the ruler 

("Show Ruler" in the "Text" submenu of 

the "Format" menu in TextEdit) and 

ensure this field is indented properly.

<PAGESENDER-REGARDING> Contents of the Re: field for this fax

<PAGESENDER-MESSAGE> Contents of the Message: field for this 

fax

<PAGESENDER-ISODATETIME> ISO-format date (e.g. 2002-08-30 

12:28:26 +0800)

<PAGESENDER-DATE> Long Date, format per System 

Preferences / International / Date (e.g. 

Friday, August 30, 2002)

<PAGESENDER-SHORTDATE> Short Date, format per System 

Preferences / International / Date (e.g. 

08/30/02)

<PAGESENDER-TIME> Time, format per System Preferences / 

International / Time (e.g. 12:28 PM)

<PAGESENDER-DATETIME> Long Date & Time, format affected by 

System Preferences / International / 

Date & Time (e.g. Friday, August 30, 

2002 12:28:26 Asia/Shanghai)

<PAGESENDER-SHORTDATETIME> Short Date & Time, format affected by 

System Preferences / International / 

Date & Time (e.g. 30 Aug 2002 12:28 

PM)

<PAGESENDER-TOTALPAGES> Total number of pages in fax, including 

cover

<PAGESENDER-NAME> Current recipient's name only

<PAGESENDER-COMPANY> Current recipient's company only

<PAGESENDER-FAXNUMBER> Current recipient's fax number

Add Your Own Cover Page

To use a cover page created in another application, choose Link Cover Page... You may 

choose any RTF, RTFD, or PDF document, including those created by TextEdit, AppleWorks 

and Microsoft Word. Note: When saving cover pages in AppleWorks, you must add your 

own ".rtf" extension for those documents to appear.
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The same list of tags above will be replaced if they appear in your added cover page. 

Edit a Cover Page

To open an existing cover page for editing in the application with which it was created, 

select the name of the cover page from the Edit submenu. 

Remove a Cover Page

To remove an existing cover page from the list, select the name of the cover page from the 

Unlink submenu. The file will not be deleted, and you may restore the removed cover page 

to the list by using Link Cover Page.

Cover Page Notes

�●     Only the first page of your custom cover page will be processed as the cover page, 

even if you choose a document which has more than one page. PageSender does 

not support multi-page covers at this time. 

�●     PDF cover pages must be edited in PDFpen in order to add tags to the page. TAGS 

CAN BE EMBEDDED IN ANY TEXT IMPRINT. 
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help: Dialing Preferences

PageSender can use Smart Dialing to be clever about how it dials the phone, relieving you 

of much of the burden. PageSender comes configured for 1 + ten digit dialing in North 

America. Please read on for additional dialing configurations.

General Dialing Notes

�●     Special characters useful in the Dialing Prefix or Dialing Suffix: 

�❍     ̂  - (caret) instructs modem to use calling tones, allowing fax/(answer)

phone devices to identify your call as a fax 

�❍     , - (comma) pause for two seconds 

�❍     @ - (at symbol) wait for silence 

�❍     & - (ampersand) wait for credit card tone 

�❍     P - use pulse / rotary dialing 

�❍     T - use tone dialing 

�❍     W - wait for (another) dial tone 

�●     To dial 9 for an outside line, change the Dialing Prefix to "T^9," 

�●     To disable call waiting, change the Dialing Prefix to "T^*70," 

�●     When using Smart Dialing, you must enter the area code � PageSender cannot 

recognize local numbers 

Smart Dialing is on by default. If you would prefer to enter everything which needs to be 

dialed manually, you may turn off Smart Dialing by unchecking the Use Smart Dialing 

checkbox in the Dialing Preferences.

Smart Dialing Preferences for North America

Option 1: 1 + ten digit dialing

This is PageSender's default setting. Within country code 1, PageSender 

will always dial 1 + ten digits. For example, if you enter 408-884-2320 in 

the A/C & Number column of the fax envelope, PageSender will dial 1-

408-884-2320. If you enter 707-202-7891, PageSender will dial 1-707-

202-7891.

Country Code 1

Local Area Code(s) (blank)

International Dialing Prefix 011
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Domestic Long Distance Prefix 1

Option 2: 7 digit local dialing, 1 + ten digit long distance dialing

This option requires you to set your area code. Within your area code, 

PageSender will dial 7 digits. Outside your area code, PageSender will dial 

the Domestic Long Distance Prefix plus the area code and number. For 

example, if your area code is set to 408 and you enter 1-408-884-2320, 

PageSender will dial 884-2320. If you enter 707-202-7891, PageSender 

will dial 1-707-202-7891.

Sometimes, it is necessary to dial 1 or 1 plus the area code when dialing 

within your own area code (sometimes known as "local long distance"). 

Simply add a 1 or 1 plus your area code in A/C & Number and 

PageSender will dial correctly. For example, if you enter 1-884-2320, 

PageSender will dial 1-884-2320. If you enter 1-408-884-2320, 

PageSender will dial 1-408-884-2320.

Country Code 1

Local Area Code(s)
408   (substitute your own 

area code)

International Dialing 

Prefix
011

Domestic Long 

Distance Prefix
1

Option 3: local ten digit dialing (possibly with multiple local area 

codes)

Some areas (for example, much of Canada and Denver, CO) require you 

to dial ten digits locally and 1 + ten digits for calls outside your local area 

code(s). This option requires that you set list your Local Area Code(s) 

separated by spaces and check the box labeled Dial area code for local 

calls. With the settings below, if you enter 303-555-1212, PageSender 

will dial 303-555-1212. If you enter 408-884-2320, PageSender will dial 

1-408-884-2320.

Country Code 1

Local Area Code(s)

303 720   (and check 

Dial area code for local 

calls)

International Dialing Prefix 011
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Domestic Long Distance 

Prefix
1

Option 4: always ten digit dialing

Some areas (for example, Dallas / Fort Worth, TX) require you to dial ten 

digits regardless of where you are calling. This option requires that you 

set both the Local Area Code(s) and Domestic Long Distance Prefix to 

blank. Now, if you enter 408-884-2320, PageSender will dial 408-884-

2320. If you enter 707-202-7891, PageSender will dial 707-202-7891.

Country Code 1

Local Area Code(s) (blank)

International Dialing Prefix 011

Domestic Long Distance Prefix (blank)

Smart Dialing Preferences Outside North America

While the same basic principles apply to dialing outside North America as within, it's worth 

noting that what are called area codes in North America are typically called city codes 

elsewhere and that it is very important to set your country code if you are outside North 

America. Here are some example international settings:

Hamburg, Germany

Country Code 49

Local Area Code(s) 40

International Dialing Prefix 00

Domestic Long Distance Prefix 0

With these settings, if you enter 40-411-71-222, PageSender will dial 

411-71-222. If you enter 30-2023-4269 to fax the Hilton Berlin, 

PageSender will dial 0-30-2023-4269. If you enter Ctry of 1 and A/C & 

Number of 408-884-2320 to fax SmileOnMyMac, PageSender will dial 00-

1-408-884-2320.

Hong Kong

Country Code 852

Local Area Code(s) (blank)
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International Dialing Prefix 001

Domestic Long Distance Prefix (blank)

Hong Kong has no area or city codes. With these settings, if you enter 

2845-1598, PageSender will dial 2845-1598. If you enter Ctry of 1 and A/

C & Number of 408-884-2320 to fax SmileOnMyMac, PageSender will dial 

001-1-408-884-2320.

Tokyo, Japan

Country Code 81

Local Area Code(s) 3

International Dialing Prefix 011

Domestic Long Distance Prefix 0

With these settings, if you enter 3-5776-3910 to fax Bridge1 Software, 

PageSender will dial 5776-3910. If you enter 6-6614-7800 to fax the 

Hyatt Regency Osaka, PageSender will dial 0-6-6614-7800. If you enter 

Ctry of 1 and A/C & Number of 408-884-2320 to fax SmileOnMyMac, 

PageSender will dial 011-1-408-884-2320.

Some area codes in Japan require that you dial 0 first for some numbers 

even when dialing within your local area code. For example, let's say your 

area code is set to 48 and you wish to dial 460-1111. Simply enter 048-

460-1111 as the A/C & Number, and PageSender will dial 048-460-1111.

Dialing Q&A

Why does PageSender always dial a 1 before the fax number?

PageSender comes configured for 1 + ten digit dialing, and expects you 

to include the area code in the A/C & Number column of the fax envelope. 

You can change this default with the help of the information above. To 

take full advantage of Smart Dialing, you should enter phone numbers in 

your address book in the format +[country code]-[area code]-[number] 

(for example: +1-408-884-2320). The country code for the US is 1.

How do I get PageSender to generate "calling tones" for combination fax/answering 

devices?

Please do the following:

1.  Launch PageSender Fax Center (in Applications)

2.  Select Preferences from the PageSender Fax Center menu 21



3.  Press the Dialing button in the toolbar of the Preferences 

window 

4.  Change your Dialing Prefix to T^ 

Notes:

�●     The second character in step 4 is a caret, formed by pressing 

shift-6 on a US keyboard

�●     The caret instructs your modem to send "calling tones" when 

making a fax call

�●     Newer Apple Internal Modems do not play the "calling tones" 

through the computer speaker, but all Apple Internal Modems 

generate the "calling tones" on the line

How do I set my default country code?

Please do the following:

1.  Launch PageSender Fax Center (in Applications) 

2.  Select Preferences from the PageSender Fax Center menu 

3.  Press the Dialing button in the toolbar of the Preferences 

window 

4.  Change the Country Code to whatever you'd like 

How can I dial without a dialtone (for example, from behind a PBX)?

Please do the following:

1.  Launch PageSender Fax Center (in Applications) 

2.  Select Preferences from the PageSender Fax Center menu 

3.  Press the Modem button in the toolbar of the Preferences 

window 

4.  Check the box labeled Ignore dial tone when dialing 
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PageSender is a trademark of SmileOnMyMac, LLC.

22



help: calling cards

You can use calling cards with PageSender. It's easy to use PageSender's “locations” 

functionality to set up any number of calling card dialing scenarios.

Example: Setting up an AT&T® Calling Card

Note: AT&T offers an array of calling card plans. This example uses their 1-800-CALL-ATT® 

plan. You'll need to look up your access number and PIN to adjust this example for your 

carrier.

1.  Under the PageSender Fax Center menu, select New Location from the Locations 

submenu 

2.  Name your new location “AT&T” and make it based on your Home or current 

location 

3.  Set the Dialing Prefix to T^18002255288@ 

    (the @ tells your modem to wait for silence) 

4.  Set the Dialing Suffix to ,0123456789 

    (where “0123456789” is your PIN) 

Notes

�●     For PIN-first cards, you'll enter the PIN in the Dialing Prefix 

�●     Special characters useful in the Dialing Prefix or Dialing Suffix: 

�❍     ̂  - (caret) instructs modem to use calling tones, allowing fax/(answer)

phone devices to identify your call as a fax 

�❍     , - (comma) pause for two seconds 

�❍     @ - (at symbol) wait for silence 

�❍     P - use pulse / rotary dialing 

�❍     T - use tone dialing 

�●     Special characters which may not work on newer Apple Internal Modems: 

�❍     & - (ampersand) wait for credit card tone 

�❍     W - wait for (another) dial tone 

�●     If & (ampersand) doesn't work with your card, you can use multiple commas to 

pause 

�●     To dial 9 for an outside line, start the Dialing Prefix with: T^9, 

�●     To disable call waiting, start the Dialing Prefix with: T^*70, 

�●     There's no way for PageSender to distinguish calling card and non-calling card 

faxes, so please group them separately 
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Using Calling Card Locations

When you wish to dial using a calling card, switch to PageSender Fax Center and set your 

location using the Locations submenu of the PageSender Fax Center menu. Do your calling 

card faxing. Then return to PageSender Fax Center and reset your location. Note: Do not 

change your location until the calling card faxing is complete or you'll wind up dialing 

normally rather than with your calling card.

 
AT&T and 1-800-CALL-ATT are registered trademarks of AT&T. SmileOnMyMac is not 

affiliated with AT&T.
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help: receiving faxes

When PageSender Fax Center is running, it can answer the phone to receive faxes. Select 

Preferences from the PageSender Fax Center menu and press the Receive button to set up 

the receive preferences.

Note: Close the Preferences window or switch to the Fax Center window for your changes 

to take effect. It may take a few seconds for the status bar to indicate PageSender is 

"Waiting to receive" after you've turned receiving on.

Receive faxes after X ring(s)

Check this box to activate receiving faxes. Enter the number of rings to 

wait before the fax modem answers. If you enter a value outside the 

range 1-9, the number will be adjusted to fit in that range.

Launch PageSender Fax Center at login

PageSender Fax Center must be running in order to receive faxes. If you 

would prefer PageSender Fax Center to automatically launch when you 

log in, ensure this box is checked after you have checked the "Receive 

faxes" box described above.

When a fax is received

The checked actions are performed after a fax is received by PageSender Fax Center.

Notify me

If this is checked, the PageSender Fax Center icon in the Dock will 

"bounce" when a fax is received. To stop the "bounce", activate 

PageSender Fax Center.

Open in PDF viewer

If this is checked, received faxes will be opened in your default PDF 

viewer. This will occur in the background so as not to disrupt your current 

work.

Print to:

If this is checked, received faxes will be printed to the printer selected in 

the popup. This allows PageSender to behave like a regular fax machine, 

printing faxes immediately as they arrive. Note: We do not recommend 

choosing PageSender as the printer. Please choose a physical printer or 

do not choose this option.

Send Email to:
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If this is checked, an Email will be sent to the specified address(es) with a 

subject of [PageSender] N page fax from: SENDER, where N is the 

number of pages and SENDER is the station number of the sending fax 

device. Enter addresses in the form of Full Name <email@address.com>, 

or simply email@address.com, separated by commas.

Enclose fax file with Email

If this is checked, PageSender will enclose the received 

fax file (in PDF format) in the Email notification. This 

allows the receiving computer to forward all incoming 

faxes to Email.

Run AppleScript:

In case we don't support your favorite received fax option, you're 

welcome to create your own using AppleScript. Check this box then press 

the Edit button to view our sample script. Edit that script to suit your 

needs then save it.

Note: The received fax AppleScript is located at: /Library/Printers/

PageSender/Scripts/Received Fax.scpt. It must be saved as a data fork 

script (lowercase compiled script in Script Editor's Save As... Format pop-

up menu).

Save faxes to:

Choose the folder to which incoming faxes are saved. Faxes saved to this 

folder will not be deleted by PageSender, even when deleted from the Fax 

Center list.

Use Hot Key to answer faxes manually:

To establish a system-wide Hot Key to answer faxes manually without 

switching to PageSender Fax Center, select this checkbox. To change the 

key combination for the Hot Key, press the button and select a new key 

combination.
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help: sending an email

You can send as an email any document you can print, via PageSender:

1. In any Mac OS X application, select Print from the File menu.

2. Select PageSender-Email as the printer.

3. Select PageSender Email where the print dialog usually shows Copies & Pages if it is not 

shown automatically.

PageSender presents an envelope which lets you send anything you can 

print as an Email anyone can read:

 
4. Click the Open Address Book button.

5. Drag an address into the white area below Name and Address.

6. Press the Message tab and enter a subject and brief message.

7. Press the Print button.

A new message will appear in your Email application. It will be addressed 

to whomever you chose in Step 1, and it will have an attached Portable 

Document File (PDF) of what you just printed which can be read by 

virtually anyone.

6. Edit the message if you wish and send it as you normally would from your Email 

application. You can also enter the message in the Message panel of the PageSender Email 

portion of the Print dialog.
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Advanced Email Options

Add a recipient directly by clicking the Add button and editing the Name and Address 

directly in the PageSender address list, just as you might edit a filename in the Finder.

Sort the recipient list by clicking the Name or Address column title in the recipient list. Click 

again to reverse the sort order.

Add Cc or Bcc recipients by clicking the Cc or Bcc tab.

Enter a short message by clicking the Message tab. If you have purchased PageSender and 

would rather not include the PageSender tag line in your Email, you may uncheck the 

Include PageSender tag line checkbox, though the author would really appreciate if you 

would continue to tell people about PageSender.

Add your most recent recipients quickly by choosing them from the Recent Emails popup 

menu. Recent Emails are listed in reverse chronological order for your convenience.

Send directly from PageSender without opening the message in your Email application by 

unchecking the Edit outgoing message before sending checkbox.

Drag vCard files directly into PageSender.

Carbon copy (CC) yourself on PageSender Emails: 

1.  Launch PageSender Fax Center 

2.  Choose Preferences from the PageSender Fax Center menu 

3.  Select Email from the preferences toolbar 

4.  Check the Copy me on PageSender Emails checkbox 
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help: AppleScript

PageSender includes support for automation via AppleScript as well as several reference 

examples.

Introduction to Scripting PageSender

PageSender is a printer driver. Scripting is done by establishing preset values (for 

example, a fax recipient's phone number) to be used by the PageSender printer driver for 

a particular application then forcing that application to print.

Some applications, such as TextEdit and OmniGraffle (and probably most other Cocoa 

applications), support printing without user interaction using the AppleScript "print" 

command. Three of the example scripts included with PageSender demonstrate this 

technique using TextEdit.

Other applications, such as FileMaker Pro and Microsoft Word, have their own internal 

scripting language which supports printing without user interaction. There's a FileMaker Pro 

example included with PageSender. For Microsoft Word, one strategy is to record a macro 

in the global template named say "PrintDocument" where all you do is print the current 

document then stop the recording. Now in AppleScript, you can get Microsoft Word to print 

without using interaction by using: do script "PrintDocument()". We welcome your scripting 

techniques feedback.

Example Scripts

Three example scripts and one FileMaker Pro database are included with PageSender. They 

are found in: 

/Library/Application Support/PageSender/AppleScript Examples.

Email from Script Example - Demonstrates using PageSender to automate Emailing 

PDFs of whatever you can print. Note that you can set the subject and content using the 

email info class, and you can even set the recipient type of the email recipient if you'd like 

to add CC or BCC recipients.

Fax from Script Example - Demonstrates using PageSender to automate faxing whatever 

you can print. Note that you can set multiple cover pages, and you can add additional 

replacements to your custom cover pages.

Prefill Envelope Example - Demonstrates using PageSender to pre-fill the print dialog. 

Perhaps you wish to pre-fill the print dialog as a convenience yet allow the user to change 

things before sending. This shows you how.

FileMaker Pro Example - We're just casual FileMaker Pro users here at Smile Software, 

but we thought it would be useful to put together a basic scripting demo. The purpose of 

the example is to give an idea of how one might use PageSender to automate the Emailing 

or faxing of invoices from a database. There are two layouts - Data Entry and Invoice, and 

there are two scripts - Fax Invoices and Email Invoices. The basic idea of the script is to 

find each data entry record individually, write a customized AppleScript to the global Script 
29

http://www.smileonmymac.com/
mailto:support@pagesender.com?subject=pagesender%20applescript
file:///Library/Application%20Support/PageSender/AppleScript%20Examples


field, execute the script, print the invoice (thereby Emailing or faxing it via PageSender), 

wait a moment for the print job to flow through the queue and repeat. In the FileMaker Pro 

8 version of the example, we have FileMaker Pro generate a PDF and pass it directly to 

PageSender to avoid the delay inherent in going through the print queue. Scripting experts 

- please feel free to send feedback.

Scripting Caveats

Here are some things to watch out for when scripting PageSender: 

�●     The application name property of the preset must be set to whatever that 

application uses as the title of its applications menu. For example, the 

application name of Microsoft Word is Word. 

�●     Only one preset per application may be in effect at one time; if you save another 

preset for the same application, it will overwrite the previous one. 

�●     One preset may contain only one address type - email or fax, not both, though it 

may contain many addresses of that type. 

�●     Presets are ephemeral - they "live" only for one print job, whether that job is 

automated via AppleScript or run by the user. You will have to write a new preset 

for each print job. 

�●     Presets are stored in /Library/Page Sender/Presets. Do not try to write your own 

preset files, as we may change the file format in the future. You may, however, 

remove a preset file (as you might wish to do if the user aborts your script). 

Customizing Email and Address Book Access

PageSender's own AppleScripts are stored in /Library/Scripts/PageSender. There are two 

types of scripts: those for Address Books and those for Email Clients. You can add support 

for additional Email clients by writing additional scripts using the existing scripts as a 

template. If you would like to contribute additional scripts to the product do send them to 

us.

How do I learn AppleScript?

Alas, that is beyond the scope of PageSender's online help. You can find a great many 

resources by starting at Apple's AppleScript Home Page. Happy scripting! 

© 2007 SmileOnMyMac, LLC. All rights reserved. 
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help: how to purchase and register

PageSender costs US $39.95 per copy (plus any applicable taxes). 

The fastest and easiest way to purchase PageSender is:

1.  Select Purchase / Register / Upgrade... from the PageSender Fax Center menu of 

PageSender Fax Center

2.  Press the Buy Now button

3.  Fill in your particulars and follow the instructions

4.  The payment processor will process your order in 30-60 seconds 

5.  Once your purchase is complete your serial number will be stored automatically 

You can also buy using one of the following methods:

�●     Purchase via our eSellerate Web Store 

�●     Purchase via our Kagi Web Store 

�●     Purchase by phone 

�●     Purchase by FAX 

Non-profit organizations may request donations of PageSender by Emailing 

support@pagesender.com. Please describe your organization, its mission, and your 

intended use for PageSender.

Registering an Existing Purchase

1.  Select Purchase / Register / Upgrade... from the PageSender Fax Center menu of 

PageSender Fax Center

2.  Copy and Paste your name and serial number from your receipt into the 

registration dialog 

3.  When the name and serial number match, the Register button will light up; press 

Register 

Upgrading an Earlier Purchase

1.  Select Purchase / Register / Upgrade... from the PageSender Fax Center menu of 

PageSender Fax Center 

2.  Copy and Paste your name and serial number from your original receipt into the 

registration dialog if they don't appear automatically 
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3.  PageSender will check to see if you qualify for a free upgrade or whether you need 

to purchase a version 4 upgrade license 

4.  If the upgrade is free the Register button will light, otherwise you can purchase 

the upgrade via the Buy Now button and follow the instructions to purchase the 

upgrade 

5.  The Register button will light up; press Register 
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help: support

We answer common support questions in our FAQ (frequently asked questions).

Please review the FAQ before requesting support.

If the FAQ does not answer your question, please include as much information as you can 

in an email to support@pagesender.com.
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